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Objectives

* Quick introduction to OVSR

« What is the value in reporting?
 How to get started.

« Harnessing the power of OVSR
« Examples of product usage

« Future directions of OVSR




OpenView Service Reporting

% Benefits
- Painless reporting
- Out-of-the-box reports
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What Service Reporter is
AND what it is NOT:

e |s:

— A high level reporting tool that uses data from
MeasureWare Agent and ITO database systems
to summarize weekly performance

 Not:
— A replacement for PerfView Analyzer
— Not a real-time tool
— Not an alarm generator/display engine
— Not intended for drill-down activities



Automatically find machines with MWA agents on local NT domain.

To discover HP-UX, Solaris, AIX, SINIX, Reliant OS, NCR agent systems
automatically you need an NFS service (like Hummingbird Maestro NFS)

“Bulk discovery” allows machines to be discovered from text file input

Will find new MWA agents when added to environment (scheduled based
on user need)

Time-out if discovery can’t find all systems in allotted time

Discovered systems report provides system name, OS info, machine type,
disks, CPU, memory and networks

Discovery is ARM’d
Logs discovery progress tracking to Reporter status file

Discover ITO similar to Discover but discovers I'TO agent systems.




Gathers data into central DB based on assigned metric lists

Validates metric list on remote node

Gathering available at different summarization levels (5 min, hourly, 3
hrs, etc)

Will time-out based on threshold and catches up on missed-data from
previous days

Gatherer report generated including last status, and scheduling info

Gatherer is ARM’d

Estimated gathering time is 15 seconds/system for standard metric set
(one week of data).

Logs to Reporter status file for easy tracking of gathering progress

Process level gathering is possible, but be aware that this consumes a lot
of disk space

Gather ITO is used to collect ITO metrics for long term ITO trending and
is saved in the MS Access 97 database




* Runs as a service and controls the execution of all scheduled Reporte:
functions

* Provides “time-out” capability to kill programs that run longer that
practical (default settings or user controlled).

* Allows individual system gathering scheduled manually by need
* Logs to Reporter status file for tracking scheduled activities

* Allows execution of any user-defined program including the passing of
user parameters

* Ensures all Reporter processes complete before the next process starts-up
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* Line of business managers:

* Are my customers requirements being met?
*  Will my customers requirements continue to be met?
« Am I receiving the levels of service that I am paying for?

 I'T Managers:

« Am I delivering the contracted levels of service?

* Is my current configuration able to handle the current and future
business requirements?

 Has the workload changed? Was this change anticipated/planned?

e IT Administrators:

*  Where do I need to focus my staff to improve customer service?

* How can I reduce the number of incidents that need direct
operations involvement?



How can you manage an environment if you don’t know what that
environment is experiencing?

How can IT be a valued business partner if IT doesn’t understand their
value to the business?

How can you expect customer satisfaction if you don’t know what you are
delivering to them?




* Resource utilization

* Resource availability

* Business transaction throughput/completions/aborts/service times
Number, Severity & Type of incidents

* Resolution time of incidents

* Operator statistics (number, time/operator/incident)

* Node assignment
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Windows I/F to user-controlled reporting features:
— Scheduling

— Discovery of systems

— Discovered systems and grouping

— Reports and custom report definitions

— Metric lists

— Configuration of Databases/Holidays/Shifts/Auto Groups/Options

« Shift configuration to further customize your reports (Prime,
Graveyard,Swing, User)

* View into Reporter status file

« Configuration of Reporter parameters (tracing, time-outs, concurrent
programs, maintenance)

 Comprehensive online help and Concepts Guide
* Drag-n-drop capability and Multiple select in Ul



Step 1: Build A Group
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Which Systems?
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Problems?

Trace Level 1-9, defines detail of information traced in modes of
operation. File ->Configuration ->Options

o Status Windows can be turned on/off for the various modes of
operation. File ->Configure ->Status Window

* General status information is kept in Status.reporter file
renames to oldstatus.reporter when it reaches 100KB

e Trace files (ie. Trace.Discover, Trace.Gather) for the different
phases log same information as the status pane. These files named
get renamed "'traceold...." when they reach S00KB.



& how to | access them?

* Microsoft Access 97 & Oracle are the only databases that is
currently supported by Service Reporter.

« Note: The Microsoft Access 97 database can reach a maximum
size of 1 Gigabyte of data.

« A standard database size (7 days of data w/standard metric
collection) is ~ 45 kbytes per system

* Maintenance is scheduled once per day to clean the data base of
unwanted data

* Data retention period is user-configurable (in days) through the
Reporter Ul (metric list ‘retain # days’)

* Need to identify the database in the report template:

e Ifyou are creating your own report templates with Crystal
Reports "™ you must specify the database you are connecting to in
the ‘Create Report Expert’, which is the first step in creation of a
custom report template. From the ‘Data’ tab select SQL/ODBC
and from the ‘Log On Server’ window that pops up, go down the
list to ‘ODBC-Reporter’, select and click ‘OK”.



System Discovery

« MeasureWare discovery is a two step process.

* Discovering systems through network browsing relies on the NT operating
system, which lists all systems known to the NT network. It is possible for
NT to know many thousands of systems so you will probably want to
restrict the systems to be searched.

* Generate a list of system names

* Probe each system for the existence of a MeasureWare Agent. ITO
discovery involves copying system nodes and nodegroups from the ITO
database.




iscovery

Creating a bulk discovery file from a Un*x /etc/hosts file

HP supplies a file to extract the unix system names from the /etc/hosts file.
The file ‘c:\rpmtools\newconfig\hosts2discover’ will convert an /etc/hosts
file (found on a Un*x system) into a bulk discovery file. Copy this file to
your Un*x system and set it’s permissions to allow execution (if not
already set) and run ‘$ hosts2discover’. The ‘discoversys.txt’ file will be
created in the directory that you are currently in. Copy this file to the
Service Reporter console (into the c:\rpmtools\data\ directory ), then
follow the instructions for performing bulk load.




manage from one
VantagePoint Reporter
station?

Scalability Example:

Systems supported / Database space
required

200 MHz Pentium pro, single processor
64 MB memory

1600 MeasureWare Agents
84 MB for database (approximate)

200 MHz Pentium pro, dual processors
96 MB memory

2492 MeasureWare Agents
131 MB for database (approximate)

400 MHz Pentium-II, dual processors
192MB memory

4577 MeasureWare Agents
240 MB for database (approximate)




* You can easily make minor modifications to the default report templates
such as replacing the '"OpenView Service Reporter' graphic with a

company logo. To edit the report templates you must purchase a copy of
the Crystal Reports product.




*  Why?

*  When you want to report on data from new or modified metric
lists.

* i.e. new data from a MeasureWare DSI data source.

 Change the information on an existing report (perhaps add more
detail), different look?

* Note: If you change any default template, it is recommend to
retain the original template and save changes under a new report
template file name.



* Step 1: Specify the database

» Step 2: Choose a database table

« Step 3: Choose fields (metrics) to use in the report

» Step 4: Design the template using Crystal Reports
— Pay attention to aligning columns in web pages

e Step 5: Save the template

« Step 6: Add the report template to Reporter (right click
reports). Note the template type:

— all, group, single system
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— What is it and why?

One of the current design limitations of the Data Source Integration
feature of MeasureWare is its inability to accept more than one data point
at the same date and time value. Most of the time this is not a problem,
but it can be annoying when you want to record multiple instances.
Suppose we had similar data from several data sources, same name, just
different source, i.e disk metrics. Summarization would total the data for
the same metric, for the same time instance.




When a data source from one system is mounted on another system's
MeasureWare Agent, it is being proxied by the MeasureWare Agent.
Normally data sources are identified with the system where the
MeasureWare agent resides. It is often desirable to identify proxied data
sources with the system that originally collected the data. This process is
called deproxification.

Select Data Source

|ORA_*

Use Data Source name as System name.

[8]:4 | Qanu:ell Help |

If the actual system name is required for reporting then it should be
stored in the collected data.




Collections:

* By default, when the gather program pulls data from
MeasureWare Agents, it will not gather data past the previous

midnight.
Edit Schedule Entry K
Job Date | 2 /26/99 =
Job Time [o7.00:00 =
Frogram MNarme IGather j |
Farameters -h haggin j
Job Feset Haour j
Fun Time 15 i’ Minutes
(0]:8 Cancel | Help |




Examples of Usage..........
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Possible Disk bottleneck: AMERINTAL

The DISK graph uses the Measureware metric: GBL_DISE. UTIL PEAR. This represents the utilization of the busiest disk
during the interval This wtilization is the percentage of time during the interval that the busiest disk was performing I0
tranisfers. It is not an average utilization over all the disk devices. A peak disk utilization of more than 50 percent often
indicates a disk bottleneck situation. Blower disk devices show a higher utilization with lower IO rates than faster disks.
Only local disks ate counted in this measurement. NF3 dewvices (and DU devices on HPTIX 2.0) are excluded.

The CACHE graph uszes the Measurewate metric: GBL MELM CACHE HIT PCT. This represents the petcentage of
buffered reads satisfied in the buffer cache (rather than going to disk) during the interval. This metric is obtained by
measuring the mumber of buffered read calls that were satisfied by the data that was it the system buffer cache. Reads that
ate 110t i1 the buffer cache result in sk IO, Unbuffered IO and virtual memory 10 (incleding memory mapped files), are not
couited in this metric,
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This report was prepared on 41500, 4:27:12AM
This repott shows data during the reporting interval of 4710000 - 471500, The graphs are prepared using Hourly data.
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Outlook Web Access Connections

HTTPF Zervice Current Connections - ME3Exchangel3 15 A ctive User Count - Mumber of user connections that have shown some activity in the last
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Outlook Client Connections

MEExchangzelZ 13 Active User Count - Humber of user connections that have shown some activity in the last 10 mitnates.
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CPU Busy

AIT-S Boise NT Team

Thiz repott shows the average CPU busy percent for the syatem during the reporting interval of 4000 - 471400, Some systems may have a higher busy
percent but at overall lower total CPU eyeles consumed if data iz not available for that system for the entite reporting interval. CPU percentage i detived by

dividing the GEL_CPU_TOTAL_TIME by the INTERVAL being measured.
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Thiz repott shows the total mumber of disk transfers during the reporting interval of 409/00 - 4714/00. The scale is in Thusands (F) or Millions (W) of

tratisfers.

(1) or Millions (W) of transfers.
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Memory Busy
This repott shows the memoty page transfers during the reporting interval of 49700 - 4714700, The graph shows the total mumber of pages, by Thousands
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Future Directions

* Support for additional databases.

* Support of new Measurement Engine (VP NT).
e Support for Windows 2000.

 Continued use as ‘defacto’ reporting engine.

* Service Availability from VP Service Reporter.

 Expanding data repository functionality and drill down (summary to
detail).




Questions

?




e

MeasureWare :

Agents

ITO

‘Management----- -

System

rvice Reporter Arc

Master
Scheduler

itecuure

Reporting

1

N

Database

Admin
ser Interface

Central —”

Report
Engine

T

Page(
A

Maintenance

C Report
Templates
T Reports

Report
Config




